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Мы уже неоднократно затрагивали вопросы, связанные с записью звуковых данных средствами Cubase SX. В разд. 4.4.3 описана подготовка аудиотреков к записи и пояснены многочисленные способы переключения Cubase SX в режим записи. В разд. 4.4.5 содержатся сведения об операциях, которые можно выполнять с частями и аудиосообщениями средствами окна проекта. 
В разд. 1.11.2 приведена методика использования результатов спектрального анализа при сведении стереофонических фонограмм. 
В данной главе мы расскажем о том, какие еще средства Cubase SX можно использовать для обработки звуковых данных. 
Важным условием успешной записи вокала и живых инструментов является обеспечение мониторинга. В Cubase SX можно использовать три вида мониторинга: 

·  внешний мониторинг — выводимый на мониторы сигнал не проходит сквозь Cubase SX; 

·  ASIO Direct Monitoring (сквозной мониторинг) — сигнал, выводимый на мониторы, не проходит сквозь Cubase SX, но проходит сквозь микшер звуковой карты, которым управляет Cubase SX. Условие — драйверы звуковой карты должны поддерживать сквозной мониторинг; 

·  внутренний мониторинг — сигнал проходит сквозь Cubase SX и подвергается обработке подключенными плагинами. Условие — звуковая карта должна поддерживать режим full duplex. Недостаток — задержка, возникающая при прохождении сигнала сквозь Cubase SX. 

Какой вид мониторинга использовать — решать вам. Мы порекомендовали бы использовать ASIO Direct Monitoring (если есть возможность) или внешний мониторинг. О настройках Cubase SX, затрагивающих мониторинг, см. в разд. 2.7. 
В Cubase SX запись многодорожечного проекта можно осуществлять следующими способами: 

·  последовательная запись — запись осуществляется сначала на один трек, потом на второй, на третий и т. д.; 

·  многодорожечная запись — запись осуществляется сразу на несколько треков. 

Для осуществления многодорожечной записи требуется звуковая карта с несколькими независимыми входами, поддерживаемыми на уровне драйверов. 
В процессе записи звука на треках проекта Cubase SX создаются объекты, называемые аудиосообщениями. Напомним, что аудиосообщения включают в себя ссылку на звуковой файл и набор атрибутов. Аудиосообщения могут выглядеть по-разному в зависимости от настройки Cubase SX. 
Командой File > Preferences откройте окно Preferences и выберите секцию Event Display > Audio (рис. 12.1). 


Опция Interpolate Audio Images включает интерполяцию звуковых отсчетов при отображении волновых форм. Заметить результаты интерполяции можно только при очень большом увеличении изображения волновой формы (рис. 12.2). Естественно, на качестве звука опция Interpolate Audio Images никак не отражается. Сглаживание "ступенек" реального сигнала осуществляется в самом АЦП за счет применения фильтра нижних частот. 
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Рис. 12.2. Отображение волновой формы без применения интерполяции (а), и с применением интерполяции (б)
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Рис. 12.3. Различные стили отображения волновых форм
В списке Wave Image Style выбирается стиль отображения волновых форм: 

·  Solid — волновая форма, ограниченная амплитудной огибающей заливается темным цветом (рис. 12.3, а); 

·  Framed — отображается только амплитудная огибающая (рис. 12.3, б); 

·  Solid and Framed — амплитудная огибающая отображается темным цветом, а область, ограниченная ею, заливается белым цветом (рис. 12.3, в). 

Последний стиль можно считать самым красивым, однако он больше остальных отнимает вычислительные ресурсы компьютера. На устаревших компьютерах это может оказаться ощутимым. 
Если включена опция Show Event Volume Curves Always, то амплитудные огибающие аудиосообщений будут отображаться даже тогда, когда аудиосообщение не является выделенным. 

12.1. Использование Audio Part Editor для редактирования аудиосообщений в пределах части

В ходе редактирования проекта аудиосообщения, размещенные на одном треке, могут объединяться в объекты более высокого логического уровня — части. Аудиочасти образуются в результате склеивания двух и более аудиосообщений с помощью инструмента Glue (кнопка [image: image3.png]


на панели инструментов окна проекта). Еще один способ объединения нескольких аудио-сообщений в одну часть — выделить нужные сообщения и воспользоваться командой главного меню Audio > Events to Part или аналогичной командой контекстного меню секции треков. 
Если сделать двойной щелчок на аудиочасти, то откроется окно Audio Part Editor (рис. 12.4). 
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Рис. 12.4. Окно Audio Part Editor
Данное окно предназначено для редактирования аудиосообщений в пределах части. При этом по отношению к аудиочастям доступны такие же приемы редактирования, как и в окне проекта. 
В верхней части окна Audio Part Editor расположена панель инструментов, большинство элементов которой заимствовано из аналогичной панели окна проекта. Мы перечислим лишь те из них, которые там не имеют аналогов. 
Кнопка [image: image5.png]


(Show Info) подобна кнопке [image: image6.png]


(Show Event Infoline), расположенной на панели инструментов окна проекта: она открывает/скрывает информационное поле, расположенное ниже панели инструментов. Назначение данного поля — отображение и редактирование параметров выбранного объекта (в данном случае аудиосообщения). 
Кнопка [image: image7.png]


(Solo Editor) включает режим Solo для редактируемой части. При воспроизведении всего проекта будет слышна только одна та часть, которая в данный момент открыта в окне Audio Part Editor. 
Кнопки [image: image8.png]


(Play) и [image: image9.png]


(Loop), расположенные в окне Audio Part Editor, пo своим функциям отличаются от аналогичных по виду кнопок окна проекта. Кнопка [image: image10.png]


(Play) запускает воспроизведение редактируемой аудиочасти. Причем воспроизведение осуществляется непосредственно на первую выходную шину (по умолчанию она называется BUS 1), минуя какие-либо эффекты и обработки. Если выделено хотя бы одно аудиосообщение, то воспроизведение начинается с его левой границы вне зависимости от того, где располагался до этого указатель текущей позиции. Вообще, в режиме воспроизведения указатель текущей позиции окна Audio Part Editor не связан с указателем текущей позиции проекта. 
Кнопка [image: image11.png]


(Loop) включает режим циклического воспроизведения выделенных аудиосообщений. 
Остановить воспроизведение можно повторным нажатием кнопки [image: image12.png]


(Play). 
В окне Audio Part Editor аудиосообшения могут размещаться на разных уровнях (рис. 12.5). 
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Рис. 12.5. Окно Audio Part Editor (аудиосообщения расположены на разных уровнях)
На рис. 12.5 два аудиосообшения располагаются на разных уровнях. После запуска воспроизведения будет звучать аудиосообщение, расположенное выше второго. Когда указатель текущей позиции дойдет до начала второго аудиосо-обшения (на рисунке эта позиция отмечена курсором), начнет воспроизводиться второе сообщение. Воспроизведение первого сообщения в этот момент прекратится, т. е. приоритет его уровня ниже приоритета того уровня, на котором расположено второе аудиосообщение. У всех уровней разные приоритеты. Самый низкий приоритет у верхнего уровня, а самый высокий — у нижнего. Количество уровней не ограничено. Вы можете перемещать аудио-сообщения с уровня на уровень, используя Drag & Drop (перетаскивать с помощью мыши). Если удерживать при этом нажатой клавишу <Ctrl>, то перемещение аудиосообщения в горизонтальном направлении станет невозможным. Всегда воспроизводится то аудиосообщение, которое в данный момент имеет наивысший приоритет (расположено ниже остальных). 
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Рис. 12.6. Окно Audio Part Editor (изменение положения маркера S)
Следует обратить внимание на то, что в окне Audio Part Editor доступны для редактирования в графической форме атрибуты Snap аудиосообщений: при выделении аудиосообщения у него появляется маркер S (Snap) (рис. 12.6), который можно перемешать вдоль аудиосообщения. Это реперная точка, по которой осуществляется привязка (см. разд. 4.4.4) позиции аудиосообщения во времени. По умолчанию она совпадает с началом аудиосообщения, поэтому кажется, что привязка аудиосообщений осуществляется по их левым границам. На рис. 12.7 проиллюстрирована следующая ситуация: 

·  включен режим привязки к началам тактов (нажата кнопка [image: image15.png]


(Snap), в поле Grid Selector выбран режим Ваr); 

·  маркер S не совпадает с началом аудиосообщения; 

·  при перемещении аудиосообщения оно "примагнитилось" маркером S к началу 4 такта; 

·  левая граница аудиосообщений не совпадает с началом такта. 
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Рис. 12.7. Привязка аудиосообщения к началу такта по маркеру S
На самом деле, вы можете управлять маркером S даже из окна проекта: выделите нужное аудиосообщение, установите указатель текущей позиции в то место, где должен располагаться маркер S, и вызовите команду главного меню Audio > Snap Point to Cursor. 
О редактировании амплитудных огибающих аудиосообщений мы довольно подробно рассказали в разд. 4.4.5. Поэтому сейчас осталось лишь упомянуть об одной команде главного меню, имеющей отношение к этой проблеме. Команда Audio > Adjust Fades to Range перемещает узлы амплитудной огибающей так, чтобы они располагались на границах выделенной области звукового сообщения. Соответственно применять эту команду можно совместно с инструментом [image: image17.png]


(Range Selection) как из окна проекта, так и из окна Audio Part Editor.
А теперь вопрос "на засыпку": как вывести аудиосообщения из части, чтобы они находились непосредственно на аудиотреках? Ответ: для этого есть специальная команда главного меню Audio > Dissolve Part. 

12.2. Редактирование аудиосообщений с помощью Sample Editor

В каком окне бы вы не работали (в окне проекта или в окне Audio Part Editor), но если сделать двойной щелчок на аудиосообщений инструментом Object Selection ([image: image18.png]


), то откроется окно Sample Editor. В нем для редактирования будет доступен звуковой файл, на который ссылается аудиосообщение. 
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Рис. 12.8. Окно Sample Editor
Основной элемент окна — это область, в которой отображена и доступна для редактирования волновая форма звукового файла. Естественно, вы можете изменять масштаб (zoom) отображения по вертикали и по горизонтали подобно тому, как это делается в других окнах Cubase SX. 
Для быстрого доступа к нужной части звукового файла удобно пользоваться специальной областью окна, называемой thumbnail display, которая является полным аналогом области Show Overview (см. разд. 4.4.2), доступной в окне проекта. Область thumbnail display расположена непосредственно под панелью инструментов. В ней отображается волновая форма всего звукового файла. Синяя рамка соответствует области звукового файла, доступной для редактирования. Вы можете передвигать границы рамки, при этом будет автоматически осуществляться горизонтальный скроллинг и изменяться горизонтальный масштаб. Вы можете перемещать рамку вдоль волновой формы, что аналогично горизонтальному скроллингу. 
Еще один элемент окна Simple Editor, упоминание о котором уместно в начале раздела: кнопка [image: image20.png]


(Show Info) скрывает/показывает информационную строку, расположенную под изображением волновой формы и содержащую три поля: 

·  формат и длительность звукового файла; 

·  формат представления времени (доступен для изменения); 

·  координаты выделенной области; количество изменений, внесенных в звуковой файл; числовое представление масштаба. 

Окно Sample Editor имеет несколько функциональных назначений и может иметь различный вид. Щелчком правой кнопки мыши на окне Sample Editor вызовите контекстное меню. Первые шесть команд этого меню дублируют первые шесть кнопок на панели инструментов. Дальше идут команды, дублирующие команды главного меню программы. Последней строкой контекстного меню окна Sample Editor является подменю Elements. С его помощью можно включать/отключать элементы окна Sample Editor. Перечислим их: 

·  Audio Events (дублирует кнопку [image: image21.png]


панели инструментов) — показывает/скрывает маркеры начала и окончания аудиосообщения, а также маркер атрибута Snap; 

·  Regions (дублирует кнопку [image: image22.png]


(панели инструментов) — показывает/скрывает секцию регионов; 

·  Info Line (дублирует кнопку [image: image23.png]


( панели инструментов) — показывает/скрывает информационную строку; 

·  Level Scale — показывает/скрывает шкалу уровня сигнала, расположенную вдоль правой границы окна. У этой шкалы имеется свое собственное контекстное меню, в котором можно выбрать способ градуировки: в % или в дБ; 

·  Zero Axis — показывает/скрывает линию нулевого уровня сигнала; 

·  Half Level Axis — показывает/скрывает линии, соответствующие уровню сигнала в 50% (-6дБ) от максимально возможного. 

Освежим в памяти сущность аудиосообщений. В терминологии Cubase SX аудиосообщение — это объект, включающий в себя ссылку на звуковой файл и набор атрибутов. В частности, имеются такие атрибуты, как начало и окончание аудиосообщения — адреса точек относительно начала звукового файла, которые считаются началом и окончанием аудиосообщения. Воспроизводится и отображается в окне проекта только та область звукового файла, которая заключена между маркерами начала и окончания аудиосообщения: Event Start и Event End, соответственно. В окне Sample Editor (см. рис. 12.7) эта область выделена светлым цветом. Те фрагменты волновой формы, которые располагаются за пределами области Event Start — Event End, выделены темно-серым цветом. 
Кнопки [image: image24.png]


на панели инструментов запускают воспроизведение звукового файла и включают режим циклического воспроизведения соответственно. Обратите внимание, что в данном случае речь идет о воспроизведении именно звукового файла, а не аудиосообщения. Воспроизводиться будут даже те фрагменты файла, которые лежат вне границ аудиосообщения (в темно-серой области).
Еще одно понятие, о котором стоит вспомнить, — регионы. О том, что это такое, мы рассказали в разд. 4.4.3 (подразды "Режимы записи, циклическая запись, регионы аудиосообщений"). По своей сути, регионы являются парами маркеров — две координаты, задаваемые от начала звукового файла. Все, что находится между этими маркерами, — регион. В окне проекта и окне Audio Part Editor может отображаться (и, соответственно, воспроизводиться) только один из регионов одного аудиосообщения. Для выбора нужного региона сделайте щелчок на аудиосообщений правой кнопкой мыши и в контекстном меню выберите Set to Region > название нужного региона. Самое интересное заключается в том, что регионы могут как угодно пересекаться друг с другом и вообще выходить за пределы границ аудиосообщений. Дело в том, что регионы не являются принадлежностью (атрибутами) аудиосообщений. Но и в самих звуковых файлах они тоже не хранятся. Для простоты можно принять следующую "картину мира": в проекте Cubase SX хранятся объекты-ссылки на звуковые файлы. Но эти объекты являются строительным материалом и для аудиосообщений, и для регионов. То есть можно считать, что аудиосообщения и регионы — объекты, расположенные на одном логическом уровне. 
Редактировать регионы можно с помощью секции регионов окна Sample Editor. Но об этом немного позже (см. разд. 12.2.3). 

12.2.1. Редактирование аудиосообщений

Редактирование звуковых файлов можно осуществлять даже на уровне отдельных звуковых отсчетов. 
Увеличивайте детализацию изображения до тех пор, пока не станут видны отдельные звуковые отсчеты (рис. 12.9, а). Делается это с помощью инструмента [image: image25.png]


(Zoom) или регуляторов масштаба, расположенных в правом нижнем углу области, в которой отображается волновая форма. 
Теперь можно пользоваться инструментом [image: image26.png]


(Draw), чтобы рисовать новую волновую форму (рис. 12.9, б). Таким образом можно вручную удалять из звукового файла дефекты, носящие характер кратковременных импульсов (щелчки, треск). 
Можно использовать любые приемы редактирования, характерные для традиционных звуковых редакторов: выделять фрагменты звукового файла, копировать или вырезать их в буфер обмена, удалять, вставлять их из буфера обмена. Такое редактирование называется нелинейным. 
Для выделения фрагмента звукового файла предназначен инструмент [image: image27.png]


(Range Selection). На панели инструментов расположены два поля Selection: 
в них с точностью до одного звукового отсчета можно отредактировать начальную и конечную позиции выделенной области. В поле Range отображается длительность выделенного фрагмента. 
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Рис. 12.9. Редактирование волновой формы
Применять инструмент [image: image29.png]


(Range Selection) предпочтительнее в режиме Snap to Zero Crossing, включаемом кнопкой [image: image30.png]


. Границы выделенной области будут автоматически корректироваться программой так, чтобы они приходились на точку пересечения волновой формой линии нулевого уровня. Это защита от возможных щелчков на границах редактируемых фрагментов звукового файла. 
Для работы с буфером обмена можно пользоваться соответствующими командами главного меню или контекстного меню, вызываемого щелчком правой кнопкой мыши в окне Sample Editor. Однако на практике удобнее выучить и пользоваться комбинациями клавиш для: 

·  копирования — <Ctrl> + <С>; 

·  вырезания — <Ctrl> + <Х>; 

·  вставки из буфера — <Ctrl> + <V>. 

Чтобы осуществить вставку фрагмента звукового файла из буфера обмена, следует с помощью инструмента [image: image31.png]


(Range Selection) выделить область звукового файла. Вставка будет осуществляться в позицию, соответствующую левой границе выделенной области. В принципе, выделенной области как таковой может и не быть: она может иметь вид вертикальной линии, т. е. иметь минимальную ширину. Чтобы получить такую линию, достаточно щелкнуть инструментом [image: image32.png]


(Range Selection) в нужной позиции звукового файла.
Напомним, что в разных аудиосообщениях могут использоваться одни и те же звуковые файлы. Когда вы начнете вносить изменения в звуковой файл данного аудиосообщения, может возникнуть предупреждение, показанное на рис. 12.10. Если нажать кнопку New Version, то на базе существующего будет создан новый звуковой файл, который вы и будете в дальнейшем редактировать. Соответственно звуковое сообщение будет ссылаться уже на этот новый файл. 
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Рис. 12.10. Запрос решения о создании нового звукового файла
Если нажать кнопку Continue, то новый файл создан не будет, и все ваши действия отразятся на звучании остальных аудиосообщений, ссылающихся на этот же звуковой файл. 

12.2.2. Что такое деструктивное редактирование?

Работа с буфером обмена — это далеко не единственная технология редактирования звукового файла. В подменю Audio главного меню и контекстном меню окна Sample Editor имеется множество команд, работающих применительно к выделенному фрагменту. О командах обработки, входящих в подменю Audio > Process, мы поговорим в разд. 12.5. Для обработки звуковых данных можно применять VST- и DirectX-плагины, доступные в подменю Audio > Plug-Ins. Описание VST-плагинов, входящих в поставку Cubase SX, приведено в главе 13. 
Стоит заметить, что применять команды подменю Audio можно не только из окна Sample Editor. Например, их можно вызывать, находясь в окне проекта: выделяете нужные аудиосообщения или части и вызываете нужную команду. Следует понимать разницу между недеструктивным и деструктивным редактированием. 
Деструктивное редактирование — это редактирование, при котором вносятся изменения непосредственно в сам звуковой файл. Конечно, можно воспользоваться командой Edit > Undo, чтобы отменить деструктивное действие. 
Недеструктивное редактирование — это когда в сами звуковые файлы изменения не вносятся, а новое звучание этих файлов достигается за счет изменения атрибутов аудиосообщений (громкость, атака, затухание и др.), применения эффектов, работающих в реальном времени, применения автоматизации. Ведь один и тот же VST-плагин можно применить по-разному. Например, если подключить его в разрыв аудиотрека (в режиме вставки) — это будет недеструктивное редактирование. Если вызвать этот же плагин из подменю Audio > Plug-Ins применительно к выделенным звуковым сообщениям и частям, то это уже деструктивное редактирование. Деструктивное — не значит плохое. Деструктивное редактирование решает свои задачи, а недеструктивное — свои. Например, нет никакого смысла подключать к аудиотреку плагин, предназначенный для удаления щелчков, ради того, чтобы удалить всего одну помеху. В данном случае правильным решением будет применение деструктивного редактирования: открываете окно Sample Editor для аудиосообщения, содержащего дефект; выделяете область, в которой имеется дефект; устраняете дефект с помощью специализированного плагина или методом рисования новой волновой формы. В данном случае вы уверены в том, что через несколько сеансов работы над проектом вам не потребуется вернуться к исходному варианту, в котором дефект присутствовал. 
Еще пример, на этот раз противоположный. Нет никакого смысла применять эффект хоруса из меню Audio > Plug-Ins. Здесь деструктивное редактирование ни к чему. А если через несколько сеансов работы над проектом вы захотите изменить параметры хоруса? Придется разыскивать исходный необработанный файл и повторять с ним все действия, которые были выполнены до момента применения эффекта. То есть здесь как раз уместно недеструктивное редактирование — подключение эффекта в разрыв аудиотрека и, при необходимости, использование автоматизации. 

12.2.3. Работа с регионами

Одной из основных функций окна Sample Editor является редактирование регионов. Секция регионов располагается в правой части окна. Кнопка [image: image34.png]


(Show Regions) открывает/скрывает эту секцию. Создать регион очень просто: выделяете часть звуковой волны (будущий регион) и нажимаете кнопку Add в секции регионов (рис. 12.11). Альтернативный способ — воспользоваться командой главного меню Audio > Create region(s). 

[image: image35.png]




Рис. 12.11. Окно Sample Editor (создание региона)
В списке регионов, включающем в себя три графы: Description (описание), Start (начало региона) и End (окончание региона), появится новый элемент — новый регион. По умолчанию он будет называться Region 1, но вы сразу же можете изменить это название. Также вы можете в любой момент изменить границы региона или в списке регионов, или непосредственно на изображении волновой формы. Границам регионов соответствуют маркеры, название которых состоит из названий регионов и слов Start (если это маркер начала региона) или End (если это маркер окончания региона). В нашем случае маркеры называются Region 1 Start и Region 1 End. Аналогичным образом вы можете создавать и редактировать любое количество регионов. Но отображаться в графической форме будут только маркеры текущего региона — того региона, который в данный момент выбран в списке регионов. 
Кроме копки Add в секции регионов расположено еще несколько кнопок. Перечислим их: 

·  Remove — удалить текущий регион; 

·  Select — выделить область звукового файла, соответствующую текущему региону; 

·  Play — воспроизвести текущий регион. 

Вообще, Cubase SX удивительная по гибкости программа. С ней можно делать все, что угодно. Возможностей так много, что для некоторых из них тяжело привести практические примеры использования. Как, например, использовать регионы? Основное их назначение — применение режима циклической записи для создания нескольких дублей (регионов) одной и той же партии вокала или живого инструмента (см. разд. 4.4.4.). 
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Рис. 12.12. Создание аудиосообщения из региона
А вообще, с регионами можно делать очень многое. Например, из них можно создавать аудиосообщения. В списке регионов на самом деле не три графы, а четыре. Самая первая графа не имеет названия. Тем не менее, можно мышью схватить поле этой графы, соответствующее нужному региону (рис. 12.12, а) и перетащить регион в окно проекта или в окно Audio Part Editor (рис. 12.12, б). Когда вы отпустите кнопку мыши, на выбранном вами месте возникнет новое аудиосообщение (рис. 12.12, в). Его начало и окончание будут соответствовать границам региона. 
Также вы можете использовать команду главного меню Audio > Events from Regions для того, чтобы создать из всех регионов звукового файла набор аудиосообщений. 
Еще одна вспомогательная функция — Audio > Events as Region — работает следующим образом: создает регион, начало и окончание которого соответствуют началу и окончанию аудиосообщения. 

12.2.4. Работа с лупами

Прежде чем перейти к рассказу о работе с лупами, на всякий случай напомним о том, что же такое лупы. Классический барабанный луп — это фрагмент барабанной партии, записанный в определенном темпе. Причем длина лупа кратна целому числу тактов. Если воспроизводить такой фрагмент в цикле (отсюда и название лупа — "Loop" — петля (существительное), двигаться по кругу (глагол)), то создастся ощущение непрерывной игры. Лупы могут быть не только барабанными, но и мелодическими (грувами). Зацикленный грув вызывает ощущение непрерывной игры. 
В настоящее время на дисках и в Internet можно найти множество коллекций лупов. Композиция будет звучать очень монотонно, если на всем ее протяжении будет звучать всего один луп. Поэтому лупы обычно поставляются наборами, в пределах которых все лупы записаны в одном темпе на одних инструментах, но соответствуют разным частям композиции. Например, вступлению, переходам и т. п. 
Несмотря на большое количество коллекций лупов, найти подходящий луп для вашей композиции не просто. Что значит "подходящий"? Это значит то, что он вам должен нравиться, быть уместным в композиции определенного стиля и подходить по темпу. Допустим, вам понравился какой-то луп, который был записан в темпе 126 долей в минуту. Да вот беда, темп вашей композиции равен 120. К тому же вы не уверены, что вам не придется изменить темп до какого-то третьего значения. Можно было бы изменить длительность лупа с помощью звукового редактора (например, с помощью Cool Edit Pro, подробно рассмотренного в книгах [10, 12, 45]) таким образом, чтобы подогнать луп под нужный вам темп. Однако при этом изменится тональность лупа. Алгоритмы изменения длительности сэмпла без изменения его тональности эффективно работают только с аудиосигналами, содержащими 
чистый тон. Звуки барабанов и перкуссии являются аудиосигналами шумоподобными, поэтому результаты работы таких алгоритмов не всегда являются удовлетворительными. Решение этой проблемы уже давно найдено и используется во многих программных продуктах, включая Cubase SX: в лупе выделяются отдельные звуки (Slices). После этого программа может автоматически изменять положения этих звуков в лупе, подстраиваясь под заданный темп. 
На рис. 12.13, а показана волновая форма барабанного лупа. После применения специальных команд к аудиосообщению в нем будут автоматически выделены фрагменты (Slices), соответствующие отдельным звукам (рис. 12.13, б). Границы этих фрагментов называются Hitpoints. При изменении общего темпа проекта каждый из этих фрагментов будет смещаться по времени так, чтобы длительность одного такта лупа соответствовала длительности одного такта проекта. Однако каждый из фрагментов будет воспроизводиться со своей нормальной скоростью и поэтому их тембр не изменится. На рис. 12.13, 6 показано смещение фрагментов при увеличении темпа, на рис. 12.13, в — при его уменьшении. 
На практике все обстоит очень просто. Для импорта звуковых файлов в проект Cubase SX существует команда главного меню File > Import > Audio File. Ею следует воспользоваться для того, чтобы импортировать нужный барабанный луп. В результате откроется диалоговое окно, предназначенное для выбора файла и оснащенное плеером звуковых файлов. То есть вы можете прослушивать файлы еще до того, как они попадут в проект Cubase SX. В этом же окне можно включить опцию Auto Play: при выборе очередного звукового файла будет автоматически запускаться его воспроизведение. Cubase SX поддерживает множество различных форматов звуковых файлов, включая и специальные форматы для лупов (в них уже предусмотрено разбиение волновой формы на Slices). Итак, выбираете нужный файл и нажимаете ОК — он оказывается в вашем проекте в виде аудиосообщения на текущем аудиотреке на том месте, где расположился указатель текущей позиции. Делаете двойной щелчок на этом аудиосообщении и оказываетесь в окне Sample Editor. На панели инструментов имеется кнопка [image: image37.png]


(Hitpoint Mode). Нажимая ее, вы даете Cubase SX понять, что данная волновая форма является лупом и обращаться с ней нужно соответствующим образом. При первом нажатии кнопки [image: image38.png]


(Hitpoint Mode) будет отработан специальный алгоритм. Он выделит в волновой форме все участки, которые, "по его мнению", можно считать отдельными звуками. Запустить этот алгоритм на исполнение можно командой Audio > Hitpoints > Calculate, однако в большинстве случаев в этом нет необходимости.
После этого на изображении волновой формы появятся маркеры — Hitpoints. На рис. 12.14 мы навели на один из таких маркеров курсор мыши. Кроме того, изменится и вид панели инструментов, на ней появятся новые элементы. 
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Рис. 12.13. Иллюстрация алгоритма изменения темпа лупа
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Рис. 12.14. Окно Sample Editor (режим Hitpoint Mode)
Положением регулятора Hitpoint Sensitivity определяется чувствительность алгоритма, детектирующего резкие изменения в характере волновой формы и расставляющего Hitpoints. Во всяком случае, положение этого регулятора должно быть выбрано таким, чтобы количество маркеров Hitpoints соответствовало видимому количеству ударных звуков и не превышало его. 
Приемлемым можно считать среднее положение регулятора. В списке Use можно выбрать то, что следует считать основой для расстановки Hitpoints: 

·  Sensitivity — положение регулятора Hitpoint Sensitivity; 

·  1/4, 1/8, 1/16, 1/32 — вне зависимости от положения регулятора будут расставляться те Hitpoints, которые окажутся ближе всего к началам заданных долей такта. 

Использовать режимы 1/4, 1/8, 1/16, 1/32 можно в том случае, если вы уверены, что остальные настройки верны. А назначения настроек таковы: 

·  Bars и Beats — длина лупа (количество целых тактов и дополнительных долей в лупе); 

·  Signature — музыкальный размер лупа; 

·  Original Tempo — тот темп лупа, с которым он был записан (темп рассчитывается на основе предыдущих параметров). 

В большинстве случаев все автоматически рассчитывается так, как надо, и никакие настройки менять не требуется. 
Вы можете редактировать непосредственно сами маркеры Hitpoints. А с помощью инструмента [image: image41.png]


(Draw) вы можете создавать свои собственные маркеры. На панели инструментов также имеется переключаемый инструмент Hitpoint Edit, который выполняет одну из следующих функций:
[image: image42.png]


(Disable) — отключение маркеров, сгенерированных программой, и удаление маркеров, созданных пользователем; [image: image43.png]


  (Lock) — блокировка маркеров: заблокированные маркеры не будут исчезать при уменьшении значения Hitpoint Sensitivity; 
[image: image44.png]


(Move) — режим перемещения маркеров. Интересно ведет себя инструмент [image: image45.png]


(Play): когда вы щелкаете на волновой форме, происходит ее воспроизведение от начала или ближайшего слева маркера Hitpoint до конца или ближайшего справа маркера Hitpoint. Короче говоря, с его помощью вы можете слушать, как звучат отдельные фрагменты лупа (Slices). 
Подведем промежуточный итог. В окне Sample Editor можно разбить луп на несколько фрагментов, используя маркеры Hitpoint. При этом вы можете откорректировать их количество и расположение. Однако в большинстве случаев это не требуется. 
Переходим к завершающему этапу: вызываем команду главного меню Audio > Hitpoints > Create Audio Slices. Дальше произойдет интересная вещь: луп будет разбит на несколько отдельных аудиосообщений, границы которых будут соответствовать маркерам Hitpoints. Все аудиосообщения будут объединены в одну часть. Находясь в окне проекта, вы можете сделать двойной щелчок на этой части, чтобы рассмотреть результат в окне Audio Part Editor (рис. 12.15). Теперь исходный темп лупа не будет иметь никакого значения: луп будет воспроизводиться в соответствии с темпом проекта. 
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Рис. 12.15. Окно Audio Part Editor (луп разбит на несколько аудиосообщений)
Средствами окна проекта и командами Edit > Repeat или Edit > Fill Loop (см. разд. 4.4.5, подраздел "Копирование") можно размножить часть синхронизированного с темпом проекта лупа в нужных количествах. При этом все копии части будут ссылаться на один и тот же звуковой файл, следовательно, дополнительного места на диске будет занято совсем немного.
На рис. 12.16 показаны два аудиотрека. На верхнем аудиотреке расположено исходное аудиосообщение с лупом. Как видно, его окончание не соответствует началу нового такта — исходный темп лупа не соответствует темпу проекта. 
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Рис. 12.16. Исходный луп и результат его преобразования
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Рис. 12.17. Исходная часть с лупом (вверху) и результат применения команды Close Gaps (внизу)
На нижнем аудиотреке расположена последовательность частей, полученных из исходного аудиосообщения по описанной ранее методике. Границы этих сообщений соответствуют началам тактов, они синхронизированы с темпом проекта. 
Если темп проекта незначительно превышает исходный темп лупа, то после его синхронизации с темпом проекта на слух не будет заметно никаких артефактов. Если темп проекта меньше исходного темпа лупа, то это уже может быть ощутимо: между отдельными частями лупа будут слышны и видны паузы (см. рис. 12.15). Но и против этих пауз существует средство: к части, содержащей луп, нужно применить команду Audio > Close Gaps (разд. 4.4.5, подраздел "Склеивание, заполнение пауз"). Команда отработает с заметной задержкой: с помощью сложного алгоритма будут генерироваться недостающие фрагменты звуковой волны. В результате его работы паузы между фрагментами лупа будут заполнены так, что от них не останется и следа (рис. 12.17). Причем луп после этого будет звучать естественно.
В завершение раздела хотим сделать несколько замечаний. Во-первых, так же, как и маркеры регионов, маркеры Hitpoints не являются атрибутом аудиосообщений и не хранятся в звуковом файле. Во-вторых, механизм разметки звукового файла на отдельные фрагменты с помощью маркеров Hit-points можно использовать не только при работе с лупами. Например, Hitpoints удобно пользоваться в том случае, если нужно нарезать из одного звукового файла несколько аудиосообщений. В окне Sample Editor вы расставляете Hitpoints так, как вам нужно. Контролируете их расположение прослушиванием отдельных частей. Затем вызываете команду главного меню Audio > Hitpoints > Divide Audio Events, и исходное звуковое сообщение разрезается на несколько новых звуковых сообщений в соответствии с расположением Hitpoints. 
Вы можете превратить части звукового сообщения, разделенные маркерами Hitpoints, в регионы этого же сообщения с помощью команды главного меню Audio > Create Region(s). 

12.3. Создание шаблонов для Groove Quantize

В разд. 6.6, мы говорили о том, что одной из целей квантизации может являться преобразование ритмической структуры обрабатываемой партии в соответствии с образцовой партией. Такой алгоритм квантизации получил название Groove Quantize. Образцовая партия служит шаблоном, под который подгоняется ритм других партий. 
В целях генерации шаблонов для Groove Quantize можно использовать Hitpoints. 
За основу шаблонов можно брать звуковые файлы с записями реальной игры исполнителя. Так мы и сделаем: 

·  импортируем в проект аудиофайл (командой File > Import > Audio File); 

·  откроем окно Sample Editor; 

·  установим локаторы на границы фрагмента, соответствующего одному такту (рис. 12.18); 

·  командой Audio > Hitpoints > Create Groove Quantize создадим шаблон для Groove Quantize. 
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Рис. 12.18. В окне Sample Editor расставлены Hitpoints, необходимые для создания шаблона
Теперь командой Project > Add Track > MIDI создадим MIDI-трек, а командой MIDI > Quantize Setup откроем окно Quantize Setup. 
Шаблону автоматически присваивается имя, состоящее из имени аудиотрека, к которому была применена данная команда, и слова "Sliced" (в нашем случае Audio 01_12 Sliced). Найдем и выберем это имя в списке пресетов окна Quantize Setup. После этого ритмическая структура шаблона будет отображена в окне Quantize Setup (рис. 12.19). 
Если применить команду Audio > Hitpoints > Create Groove Quantize к одному и тому же аудиосообщению несколько раз, то в списке появятся несколько пресетов с одинаковыми именами, но, возможно, с различной структурой. 
Откроем для созданного MIDI-трека окно Key Editor. Обратим внимание на параметры квантизации. В поле Quantize автоматически появилась надпись, совпадающая с именем пресета (Audio 01_12 Sliced). В поле Length Quant. можно выбрать строку Linked to Quantize, если нужно, чтобы длительность нот, которые мы вскоре запишем, совпадала с текущим шагом квантизации. 
Нажмем кнопку [image: image50.png]


(Snap). Тактовая сетка в окне Key Editor будет преобразована согласно ритмическому шаблону. Теперь если инструментом [image: image51.png]


(Draw) записывать в окне отпечатки клавиш, то их начала автоматически окажутся привязанными к узлам сетки квантизации, соответствующей созданному шаблону. Результат представлен на рис. 12.20. 
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Рис. 12.19. Структура шаблона Groove Quantize в окне Quantize Setup
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Рис. 12.20. Ритм партии баса, полученный на основе Groove Quantize
Для большей наглядности после проведения Groove Quantize мы "укоротили" отпечатки клавиш, временно изменив содержимое поля Length Quant. и выбрав команду MIDI > Advanced Quantize > Quantize Lengths. 

12.4. Pool, импорт звука и видео

Вообще понятие пул (pool) очень часто используется в технике, когда какие-то объекты, сходные по своей природе, объединены в одном месте. Например, существует модемный пул (множество модемов собранных в одном месте), который обеспечивает многоканальный доступ к каким-либо информационным ресурсам, или пул адресов — диапазон, из которого сервер может выдавать адреса для своих клиентов. Пул в Cubase SX — это то место, где собрана вся информация о звуковых файлах и видеофайлах, связанных с проектом. Важно понимать, что значит "связанных с проектом". Вы можете импортировать звуковой или видеофайл в пул, но не размещать соответствующее сообщение ни на одном из треков проекта. То есть с одной стороны, файл может принадлежать проекту, а с другой стороны, он совсем не обязательно должен в этом проекте использоваться. Также нужно понимать, что пул является принадлежностью проекта. То есть у каждого проекта свой пул.
В пуле хранятся не сами файлы, а лишь ссылки на них. В терминологии Cubase SX эти ссылки называются клипами. У одного клипа может быть несколько версий. Причем каждая из версий ссылается на один и тот же файл. Разные версии клипов могут содержать различные регионы и разные наборы маркеров Hitpoints. 
Окно пула (рис. 12.21) открывается с помощью кнопки [image: image54.png]


(Open Pool), расположенной на панели инструментов окна проекта, или командой главного меню Project > Pool, или комбинацией клавиш <АН> + <1>. 
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Рис. 12.21. Окно Pool
Информация в окне Pool отображается в виде таблицы. Левая ее графа содержит дерево Media (носители). По умолчанию в этом дереве присутствуют три папки: 

·  Audio — здесь собрана информация о звуковых клипах; 

·  Video — здесь собрана информация о видеоклипах; 

·  Trash — мусорная корзина, в которую бросаются ненужные клипы. 

В папках Audio и Video в случае необходимости можно создавать вложенные папки. Для этого следует выбрать нужную папку, щелкнуть правой кнопкой мыши и в контекстном меню выбрать команду Create Folder. 
Итак, в дереве Media собраны названия файлов, а в остальной части таблицы приведена информация об этих файлах: 

·  Used — сколько ссылок на данный клип имеется в проекте (количество аудио или видеосообщений, ссылающихся на данный клип). Если в данном поле пусто — значит клип не используется; 

·  Status — состояние папки или клипа, отображаемое с помощью иконок; 

·  Info — информация о файле: формат представления данных, длительность и т. п.; 

·  Туре — тип файла;  

·  Date — дата создания файла; 

·  Origin Time — оригинальная позиция, начиная с которой данный клип (или его регион) был записан или импортирован в проект; 

·  Image — миниатюрное изображение волновой формы звукового клипа или региона; 

·  Path — путь к файлу. 

По любому из перечисленных полей можно выполнить сортировку. Направление сортировки задается щелчком на названии нужного поля (после каждого повторного щелчка направление изменяется на противоположное). 
Следует обращать внимание на статус клипа в том случае, если ему соответствует иконка с символом "х" (это значит, что соответствующий клипу файл находится за пределами папки проекта) или символ "?". Последний статус — повод для тревоги: на файл имеется ссылка, но по указанному пути он не обнаружен (он был перемещен или удален). В верхней части окна Pool имеется панель инструментов. С кнопками [image: image56.png]


вы должны быть уже знакомы (показать/скрыть информационную строку со статистикой по имеющимся клипам, воспроизвести выбранный клип, режим циклического воспроизведения). 
Щелчком на поле View вызывается меню. Первые его восемь команд показывают/скрывают соответствующие графы таблицы, кроме дерева Media. Команда Show All показывает все графы таблицы, a Hide All — скрывает все графы, кроме Media. Команда Optimize Width оптимизирует ширину граф. 
Кнопки + All и - All разворачивают и сворачивают все папки на дереве Media.
Кнопка Import вызывает диалоговое окно Import Medium, в котором можно выбрать и прослушать звуковой и видеофайл для последующего импорта в проект.
Кнопка Search делает доступной секцию поиска файлов (рис. 12.22). 
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Рис. 12.22. Окно Pool (секция поиска файлов)
В поле Name следует указать любую подстрок}', которая может присутствовать в имени искомого файла. Например, если указать "cde", то будут найдены все файлы, содержащие эту последовательность символов (например, "ab_CDeFg.wav"). В списке Folder выбирается один или несколько дисков, на которых следует осуществлять поиск. В этом же списке присутствует элемент Select Search Path. Если его выбрать, откроется окно Select Directory — выбора папки, в которой следует осуществлять поиск. Кнопка Search запускает процесс поиска и на его время замещается кнопкой Stop (остановить поиск). 
Файлы, удовлетворяющие условиям поиска, по мере их нахождения будут помещаться в список, расположенный в правой части секции (Name, Path — имя файла и путь к нему). 
В секции поиска файлов имеется плеер, позволяющий воспроизвести найденные файлы. Если включена опция Auto Play, то воспроизведение выбранного в списке файла будет запускаться автоматически. 
Выбранные в списке файлы можно импортировать в пул кнопкой Import. 
Вернемся к панели инструментов окна Pool (см. рис. 12.21). Последние элементы на ней — информационная строка, в которой указан путь к папке проекта, и папка, в которой будут размещаться записываемые файлы. 
Из окна Pool клипы или регионы можно перетаскивать в окно проекта или Audio Part Editor. Можно подвергать их обработке, производить изменение формата. 
Для работы с окном Pool в главном меню имеется подменю Pool с набором специальных команд. Эти же команды доступны в контекстном меню окна Pool. Правда, как и любое контекстное меню Cubase SX, оно может содержать различный перечень команд в зависимости от того, какой из объектов в данный момент выбран. Эти команды могут применяться к папкам дерева Media, к отдельным выделенным файлам или к группам выделенных файлов. Перечислим все возможные команды:

·  Import Medium — импортировать звуковой или видео файл; 

·  Import Audio CD — импортировать звук с треков CD Digital Audio; 

·  Import Pool — загрузить состояние пула из файла; 

·  Export Pool — сохранить состояние пула в файл; 

·  Find Missing Files — поиск тех файлов, на которые ссылаются клипы со, статусом "?"; 

·  Remove Missing Files — удалить из пула клипы со статусом "?"; 

·  Reconstruct — восстановление потерянного файла по истории его редактирования (возможно только в том случае, если файл имеет статус "Reconstructible"); 

·  Convert Files — преобразование формата файла; 

·  Conform Files — изменить формат файлов в соответствии с форматом, принятым в данном проекте; 

·  Create Folder — создать вложенную папку;  

·  Empty Trash — очистить мусорную корзину; 

·  Remove Unused Media — удалить из пула неиспользуемые в проекте клипы; 

·  Prepare Archive — подготовка проекта к архивированию (все внешние файлы копируются в папку проекта, а также выполняются другие мероприятия); 

·  Set Pool Record Folder — задать папку, в которой будут храниться записываемые файлы; 

·  Minimize File — минимизировать объем памяти, занимаемый файлами, за счет удаления не используемых в проекте фрагментов; 

·  Update Origin — обновить параметры Origin Time в соответствии с текущим расположением сообщений в проекте; 

·  New Version — создать новую версию клипа; 

·  Insert into Project > At Cursor — используя выделенный клип, создать в проекте аудио- или видеосообщения, начиная с указателя текущей позиции; 

·  Insert into Project > At Origin — создать в проекте аудиосообщение или видеосообщение в позиции Origin Time; 

·  Select In Project — выделить в проекте сообщения, в которых используются файлы, выделенные в пуле; 

·  Find In Pool — поиск файлов в пуле по заданному критерию. 

Удалить выбранный клип можно командой главного меню Edit > Delete (или клавишей <Backspace>). Вам будет выдан запрос: удалить клип из пула или перенести его в мусорную корзину. В любом из этих случаев все связанные с клипом сообщения тоже будут удалены. При удалении клипа из пула не происходит физического удаления файла, на который этот клип ссылается. А вот если вы захотите отчистить мусорную корзину, будет выдан запрос: стереть файлы физически (Erase) или просто удалить их из пула.

12.5. Применение встроенных обработок

Команды обработки звуковых данных средствами, встроенными в программу, содержатся в подменю Audio > Process. 
Первые три команды открывают диалоговые окна, с помощью которых реализуется деструктивное редактирование амплитуды оцифрованных звуковых колебаний: 

·  Envelope — модулировать амплитуду выбранных аудиоданных огибающей (ее форма задается в открывшемся диалоговом окне); 

·  Fade In — редактировать параметры функции Fade In (открывается диалоговое окно Fade In); 

·  Fade Out — редактировать параметры функции Fade Out (открывается диалоговое окно Fade Out). 

Внешне окна Fade In и Fade Out очень похожи на окна, описанные в разд. 4.4.5 (см. рис. 4.47, а и рис. 4.47, б). Отличие состоит в том, что здесь функции окон применяются к выделенным аудиоданным и изменяют их, а окна, о которых речь идет в разд. 4.4.5, используются для построения огибающих. Огибающие реально доступны в графическом виде, их всегда можно перерисовать заново, реализуя недеструктивное редактирование. 
Перечислим остальные команды обработки звуковых данных, содержащиеся в подменю Audio > Process: 

·  Gain — изменить уровень сигнала для выбранных аудиоданных. Командой открывается окно, в котором следует установить необходимый уровень усиления (или ослабления) сигнала, а также длительности кросс-фейда в начале и в конце выделенного аудиосообщения; 

·  Merge Clipboard — смешать звуковые данные из буфера обмена со звуковыми данными, содержащимися в выделенных объектах. Функция доступна только в том случае, если аудиоданные были вырезаны или скопированы из Sample Editor; 

·  Noise Gate — выделить фрагменты, в которых звуковые данные не превышают заданного уровня, и заменить их на абсолютную тишину (обработать звуковые данные гейтом); 

·  Normalize — произвести нормализацию отсчетов звуковых данных к заданному уровню. Командой открывается окно, в котором следует установить необходимый уровень нормализации сигнала, а также задать длительности кроссфейда в начале и в конце обрабатываемого аудиосообщения; 

·  Phase Reverse — инвертировать фазу в выбранном стереоканале. Командой открывается окно, в котором следует выбрать канал (правый, левый или оба канала), а также установить длительности кроссфейда в начале и в конце обрабатываемого аудиосообшения; 

·  Pitch Shift — сдвинуть высоту тона выделенного фрагмента аудиоданных; 

·  Remove DC Offset — удалить постоянную составляющую из выделенных аудиоданных (одна из операций, необходимых для предотвращения возникновения щелчков в местах склейки фрагментов аудиоданных); 

·  Reverse — реверсировать выделенные аудиосообщения (переписать аудиоданные в обратном направлении, поменять местами начало и конец аудиосообщения); 

·  Silence — заменить выделенные аудиоданные на абсолютную тишину; 

·  Stereo Flip — панорамировать выбранным способом левый и/или правый стереоканалы; 

·  Time Stretch — изменить длительность и темп выбранного фрагмента аудиоданных, не затрагивая высоту его звучания. 

Назначение некоторых функций не нуждается в подробных разъяснениях, поэтому остановимся только на командах Noise Gate, Pitch Shift, Stereo Flip и Time Stretch. 

12.5.1. Noise Gate

Командой Audio > Process > Noise Gate открывается окно Noise Gate, представленное на рис. 12.23. 
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Рис. 12.23. Окно Noise Gate
Суть обработки заключается в том, что программа просматривает выделенные аудиоданные, находит те из них, уровень которых не превышает заданного порога, и заменяет их тишиной. Фактически здесь реализован виртуальный гейт (см. разд. 1.10.2). В окне можно выбрать следующие параметры гейта: 

·  Threshold — порог срабатывания гейта; 

·  Attack Time — время, которое требуется для гейта, чтобы открыться полностью после того, как уровень звукового сигнала превысит пороговый уровень; 

·  Min. Opening Time — минимальное время, в течение которого уровень звукового сигнала должен оставаться выше порога для того, чтобы гейт оставался открытым; 

·  Release Time — время, которое требуется для гейта, чтобы закрыться полностью после того, как уровень звукового сигнала станет ниже порогового уровня. 

Если установлен флажок Linked Channels, то гейт открывается только в том случае, когда порог будет одновременно превышен уровнями сигналов и левого, и правого каналов. 
Кнопкой More открывается дополнительная секция окна (рис. 12.24). 
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Рис. 12.24. Расширенный вариант окна Noise Gate
Регулятором Dry/Wet mix устанавливается соотношение между уровнями исходного и обработанного сигналов в итоговом миксе. 
Флажком Pre-CrossFade включается кроссфейд в начале обрабатываемого фрагмента аудиоданных, а соответствующим слайдером регулируется время кроссфейда. Флажок и слайдер Post-CrossFade обеспечивают кроссфейд в конце обрабатываемого фрагмента аудиоданных. 
Нажав кнопку Preview, можно предварительно прослушать звучание, которое приобретут аудиоданные после обработки. 
Для того чтобы программа приступила к выполнению обработки, следует нажать кнопку Process. 
Аналогичные элементы имеются и в других окнах. В следующих разделах мы их описывать больше не будем. 

12.5.2. Pitch Shift

Командой Audio > Process > Pitch Shift открывается окно Pitch Shift (рис. 12.25, 12.26). 
Pitch Shift позволяет изменять высоту тона выделенного фрагмента аудиоданных, не затрагивая его длину. Основное применение функции состоит в транспонировании в другие тональности записанных вокальных партий и партий в исполнении реальных инструментов. Кроме того, с помощью Pitch Shift можно корректировать по высоте те фрагменты партии, которые певцом или музыкантом исполнены фальшиво. Поскольку одновременно можно задавать не один, а несколько интервалов транспонирования, Pitch Shift способен выполнять также роль гармонайзера: формировать заданные аккорды, основанные на тоне обрабатываемого фрагмента аудиоданных. 
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Рис.12.25. Окно Pitch Shift, вкладка Transpose
В окне Pitch Shift имеются две вкладки: вкладка Transpose, предназначенная для сдвига высоты тона на определенную неизменную величину, и вкладка Envelope, позволяющая графическим способом задавать изменение тона во времени. 
Рассмотрим сначала вкладку Transpose (рис. 12.25). Самым заметным элементом вкладки является изображение клавиатуры (Keyboard Display). Клавиатура позволяет в графической форме задать интервал (интервалы) транспонирования в полутонах. 
Красным цветом выделена клавиша, соответствующая основному тону. 
К фактической тональности или высоте тона исходных аудиоданных красная клавиша имеет косвенное отношение. Например, если вы обрабатываете звук до, исполненный вокалистом, а в качестве основной ноты выбрали ре, это вовсе не значит, что после обработки до превратится в ре. Выделенная красным цветом клавиша просто служит началом системы координат, точкой, относительно которой отсчитывается интервал транспонирования. При желании вы можете переместить красную метку в другую область клавиатуры, нажав <Alt> и щелкнув на необходимой клавише. Для смены основной ноты служат также элементы группы Pitch Shift Base. В раскрывающихся списках Root note/Pitch выбираются необходимая октава и базовая нота в пределах октавы. 
Чтобы определить интервал транспонирования, щелкните на одной из клавиш. Вы услышите соответствующий ей звук, а сама клавиша окрасится в синий цвет. Интервал транспонирования можно определить, подсчитывая полутона (клавиши) непосредственно на клавиатуре. Кроме того, он отображается и задается также в поле Transpose_Semitones группы Pitch Settings. Если установлен флажок Multi Shift, то можно пометить синим цветом несколько клавиш, с тем чтобы создать аккорд. Повторным щелчком на клавише синяя подсветка с нее снимается. 
Поле ввода Fine Tune и слайдер Cents обеспечивают корректировку высоты тона с точностью до цента, что как раз и позволяет устранять ошибки исполнения. 
С помощью поля ввода Volume и слайдера Amplitude независимо для каждой клавиши можно задать свой уровень громкости (в процентах от уровня громкости исходного звука). Это позволяет создавать многоголосные партии, в которые, кроме основного вокала, входит также и бэк-вокал (он, как правило, должен звучать тише). 
Нажав кнопку Listen Chord, можно предварительно прослушать сформированный аккорд. 
В группе Pitch Shift Mode сосредоточены элементы, предназначенные для выбора разновидностей алгоритма преобразования. 
Поле ввода Accuracy и слайдер Sound — Rhythm доступны, если в списке Algorithm выбран вариант Timebandit. С их помощью выбирается приоритетная цель преобразования. При малых значениях параметра предпочтение будет отдано тональным свойствам обрабатываемого материала, при больших — ритмическим.
В списке Algorithm можно выбрать МРЕХ Algorithm — алгоритм преобразования, отличающийся более высоким качеством, но работающий относительно медленно и не предназначенный для использования в реальном времени (поэтому кнопкой Preview воспользоваться не удастся). 
Если обработке подвергается вокальный материал, то разработчики рекомендуют установить флажок Formant Mode для того, чтобы при транспонировании сохранить формантные признаки, присущие голосу исполнителя. 
Если установлен флажок Time Correction, то при транспонировании тона сохранится неизменной продолжительность обрабатываемого фрагмента. В противном случае при повышении тона фрагмент станет короче, а при понижении — длиннее. 
На вкладке Envelope (рис. 12.26) осуществляется графическое изменение тона во времени. 
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Рис. 12.26. Окно Pitch Shift, вкладка Envelope
Щелчком на графике создается узел. Можно образовать неограниченное количество узлов, каждый из которых можно перемещать, задавая тем самым форму графика. Горизонтальный размер графического дисплея соответствует длине выделенного участка аудиотрека.
Кнопками Curve Kind выбирается способ интерполяции участков графика, заключенных между узловыми точками: отрезками прямой или гладкими кривыми (сплайнами). 
Нажатием кнопки Reset график "сбрасывается" в нейтральное состояние, приобретая вид прямой горизонтальной линии. 
В поле Range: в количестве полутонов указывается максимальный диапазон изменения тона. 
Остальные элементы знакомы вам по описанию вкладки Transpose. 
К сожалению, отсутствие разметки временной шкалы затрудняет применение вкладки Envelope, потому что невозможно точно увязать график с конкретными местами на аудиотреке. 

12.5.3. Stereo Flip

Командой Audio > Process > Stereo Flip открывается окно Stereo Flip, представленное на рис. 12.27. 
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Рис. 12.27. Окно Stereo Flip
Окно позволяет различным образом комбинировать сигналы левого и правого стереоканалов, записанные на аудиотреке. Вариант обработки выбирается в раскрывающемся списке Mode: 

·  Flip Left-Right — аудиоданньге из левого канала поместить в правый канал и наоборот; 

·  Left to Stereo — скопировать аудиоданные из левого канала в правый канал; 

·  Right to Stereo — скопировать аудиоданные из правого канала в левый канал; 

·  Merge — объединить оба стереоканала в один монофонический; 

·  Subtract — вычесть аудиоданные левого канала из правого канала и наоборот. В итоге будет удален или существенно подавлен звук источника, который в исходном сигнале был панорамирован в центр. Как правило, в центре расположен основной вокал. Поэтому алгоритм Subtract позволяет преобразовать полноценную фонограмму в аккомпанемент для караоке. 

12.5.4. Time Stretch

Командой Audio > Process > Time Stretch открывается окно Time Stretch, представленное на рис. 12.28.
С помощью этой функции можно изменить длину и "темп" выбранного фрагмента аудиоданных, не затрагивая высоту тона. 
Параметры исходного материала отображаются в группе Input:  

·  Length in Samples — количество звуковых отсчетов в выделенном фрагменте;  

·  Length in Seconds — продолжительность выделенного фрагмента в секундах;  

·  Tempo in BPM — темп, установленный для проекта; 

·  Bars — продолжительность выделенного фрагмента в формате такт .доля.часть доли.тик.; 

·  Time Signature — музыкальный размер, установленный для проекта. 
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Рис. 12.28. Окно Time Stretch
В группе Output отображаются параметры, которыми будет характеризоваться выделенный фрагмент аудиоданных после преобразования: 

·  Samples — количество звуковых отсчетов; 

·  Seconds — продолжительность полученного аудиосообщения в секундах; 

·  ВРМ — новое значение темпа; 

·  Range — новые границы аудиосообшения. 

Если нажать кнопку Set to Locators Range, то параметры аудиосообщения, отображаемые в группе Output, будут привязаны к области, ограниченной левым и правым локаторами. 
В обычном режиме растяжение или сжатие исходного аудиосообщения возможно в пределах +/-125 % (поле Time Stretch и слайдер Compress — Expand). Однако если установить флажок Effect, то коэффициент преобразования длительности может быть значительно увеличен. 
Поле ввода Accuracy, слайдер Sound — Rhythm и список Algorithm знакомы вам по материалам разд. 12.5.2. 
Конечно, ход преобразований нужно обязательно контролировать на слух, потому что не для всякого исходного материала результат будет приемлемым. 

12.6. Выявление тишины

Команда Audio > Detect Silence предназначена для выявления участков звуковых данных, на которых амплитуда звуковых колебаний ниже заданного уровня. Команда используется для выделения из продолжительных сообщений (в которых, наряду с полезной информацией, имеются участки с тишиной) более коротких фрагментов, целиком заполненных звуковыми данными. 
Функция Detect Silence вообще не затрагивает аудиоданных. Не происходит никакой их обработки, никакой замены звуковых данных абсолютной тишиной, нет и никакой экономии дисковой памяти. Функция выделяет участки с тишиной, затем (если выбрана опция Strip Silence) разбивает исходное сообщение на несколько сообщений, которые ссылаются на один и тот же файл (совершенно не измененный), но границы этих сообщений подогнаны так, чтобы в них не попадала тишина. Если выбрана опция Add as Regions, то аудиоклип (см. разд. 12.4) разбивается на регионы, не содержащие тишины. Регионы — это просто метки, поэтому в данном случае также не происходит никакой экономии дисковой памяти. В дальнейшем из регионов можно создать сообщения. 
Команда Audio > Detect Silence вызывает одноименное диалоговое окно (рис. 12.29). 
Можно выделить несколько объектов на разных треках — окно Detect Silence будет по очереди открываться для каждого из объектов. 
Функцией Detect Silence реализуется следующий алгоритм. Представьте себе ключ (выключатель), который может находиться в одном из двух состояний: замкнутом (сигнал проходит) и разомкнутом (сигнал не проходит). Программа анализирует звук: как только уровень сигнала превысит порог открывания звукового канала (Open Threshold), ключ замкнется, звуковой сигнал, пройдет со входа на выход ключа. Если уровень сигнала опустится ниже второго порога — порога закрывания звукового канала (Close Threshold), ключ снова разомкнется и наступит тишина. Двухпороговый алгоритм разделения аудиоданных на участки, содержащие полезный сигнал и не содержащие его, позволяет, с одной стороны, надежно отсечь ненужные шумы, а с другой — избежать искажения звучания музыкальных инструментов или голоса певца в фазе затухания звука. Замыкание/размыкание ключа может выполняться и в соответствии с более сложным алгоритмом анализа звуковых данных, с использованием задержек. Например, когда амплитуда звукового сигнала станет меньше заданного порога Close Threshold, ключ еще некоторое время (Min. Opening Time) будет замкнут. Аналогичным образом в поле Min. Closing Time можно задать время удержания ключа в разомкнутом состоянии после превышения уровнем сигнала второго порога (Open Threshold). Это позволяет избежать частых переключений при кратковременных резких изменениях уровня сигнала, которые на слух иногда воспринимаются значительно неприятнее, чем шум в паузах. 
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Рис. 12.29. Диалоговое окно Detect Silence
Еще один тип задержки — Pre-Roll. Однако назвать Pre-Roll задержкой можно только с большой натяжкой. Это, скорее, упреждение, чем задержка. Вектор этой задержки направлен в сторону, противоположную вектору времени. Может ли такое быть? Конечно! Ведь не зря многие считают возможности PC безграничными. Итак, в поле Pre-Roll программе указывается некоторый интервал времени. Компьютер анализирует звуковые данные, определяет момент возрастания уровня сигнала и заранее замыкает воображаемый ключ так, чтобы фаза атаки звука была слышна целиком. Это самое 
"заранее" как раз и определяется величиной Pre-Roll. Наиболее часто ненулевое значение Pre-Roll используется при работе с вокальным материалом и речью (чтобы исключить пропадание начальных звуков слов). 
Задержка, указанная в поле Post-Roll, позволяет сохранить естественное звучание окончаний слов, фазы затухания звука музыкальных инструментов, эха, реверберации. Звук будет проходить на выход ключа еще некоторое время после того, как пороговое устройство выявит резкое уменьшение его уровня. 
По существу, в данном случае мы имеем дело с программной реализацией идеального гейта. Правда, на самом деле, вместо замыкания и размыкания ключа в некоторые моменты эти места просто обозначаются метками. Порядок применения Detect Silence: 

·  выделите аудиосообщение и выберите команду Audio > Detect Silence; 

·  выполните ориентировочные настройки и нажмите кнопку Compute; 

·  проанализируйте график (вы увидите, какие именно фрагменты программа будет считать тишиной при выбранных параметрах), уточните настройки (при необходимости еще раз нажмите кнопку Compute) и наконец-то нажмите кнопку Process. 

Результат зависит от того, какой флажок выбран: 

·  Add as Regions — аудиоклип, на который ссылается аудиосообщение, будет разбит на регионы, не содержащие тишины; 

·  Strip Silence — будет создано несколько аудиосообщений, не содержащих тишины. 

12.7. История обработки и статистика аудиоданных, функция Freeze Edits

Если один и тот же звуковой файл используется в нескольких сообщениях, то перед применением разрушающего редактирования к одному из них Cubase SX предложит создать копию этого файла и дальше работать с ней (чтобы не воздействовать на остальные аудиосообщения). 
В процессе деструктивного редактирования результаты обработки звуковых сообщений сохраняются во временных файлах. Кроме того, сохраняется информация о том, какая команда и с какими параметрами была применена. Благодаря этому, можно использовать команду Edit > Undo. 
Посмотреть историю разрушающего редактирования звуковых файлов можно в окне Offline Process History, которое открывается командой Audio > Offline Process History. Там же можно произвести изменения истории редактирования — удалить какие-то обработки или изменить их параметры. После этого результирующий файл будет пересчитан с учетом новых параметров и всех ранее выполненных обработок. 
Командой Audio > Statistics запускается процедура сбора статистической информации о выделенном аудиосообщении, по окончанию которой открывается окно Statistics. В нем содержатся следующие сведения: 

·  Максимальное и минимальное значения звуковых отсчетов 

·  Пиковое значение амплитуды 

·  Величина и знак постоянной составляющей сигнала 

·  Разрядность представления и частота сэмплирования звуковых данных 

·  Локальные максимум и минимум среднеквадратических значений сигнала 

·  Среднее (для всего выделенного аудиосообщения) значение уровня сигнала 

Некоторые из перечисленных данных могут оказаться полезными при выборе параметров таких обработок, как преобразование уровня сигнала, нормализация, динамическая обработка. 
Функция Freeze Edits (команда Audio > Freeze Edits) переписывает результаты всех обработок из временных файлов в постоянные. При этом программа запрашивает ваше решение: заменить существующие (исходные необработанные файлы) или создать новые файлы. В случае создания новых файлов ссылки на старые файлы по-прежнему останутся в пуле. Но все аудиосообщения, подвергшиеся деструктивному редактированию, будут основаны на новых версиях клипов (см. разд. 12.4), которые будут ссылаться на новые файлы. 

